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Preface

Disclaimer of Warranty
AgilePoint, Inc. makes no representations or warranties, either express or implied, by or with respect to anything
in this document, and shall not be liable for any implied warranties of merchantability or fitness for a particular
purpose or for any indirect, special or consequential damages.

Copyright
Copyright © 2013 AgilePoint, Inc. All rights reserved.

Trademarks
AgilePoint, Inc. and AgilePoint's products are trademarks of AgilePoint Inc. References to other companies and
their products use trademarks owned by the respective companies and are for reference purpose only.

Government Rights Legend
Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the applicable license
agreement and as provided in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-7013(c)(1)(ii)
(Oct 1988), FAR 12.212(a) (1995), FAR 52.227-19, or FAR 52.227-14, as applicable.

Virus-free software policy
AgilePoint recognizes that viruses are a significant security consideration for our customers. To date, we have
had no report of AgilePoint BPMS carries any virus. AgilePoint takes the following measures to ensure our
software is free of viruses upon delivery:

• AgilePoint is built on top of Microsoft .NET framework. The pre-compiled executable is a.NET Common
Language Runtime (CLR) application, not a native machine binary. As far as is known at this time, there are
no viruses that infect .NET CLR executables.

• The virtual environment for the product packaging process in is fully isolated and protected, and anti-virus
software is installed and running during packaging.

• The deliverable package is scanned by anti-virus software before upload to our customer download site.

Document Revision Numbers
AgilePoint documentation uses the revision number format rX.Y.Z. The letters and numbers in this revision
number can be interpreted as follows:
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• r - Indicates "revision." This helps to differentiate the document version numbers, which start with v.

• X - The major version number for AgilePoint BPMS to which this document refers. For example, AgilePoint
releases 5.0, 5.0 SP1, and 5.5 would all have an X value of 5.

• Y - The major document revision number. This number typically changes only when either there is a new
AgilePoint release, or there are major changes to the document.

• Z - The minor document revision number. This number is incremented each time the document is
republished.

AgilePoint Documentation in PDF and HTML
AgilePoint documentation is provided in both print-friendly (PDF) and web-based (HTML) formats.

Advantages of HTML Documentation

• HTML is the primary delivery format for AgilePoint documentation.

• Unified, global search across all documentation. PDF documents allow you to search only within the context
of a given PDF file.

• All hyperlinks supported. Links in PDFs are only supported in certain contexts.

• "One-stop shopping" for all information related to AgilePoint BPMS.

• The HTML documentation is updated more frequently than the PDF documentation. Web-based
documentation is updated periodically between AgilePoint releases to address errors and omissions, but the
PDF documentation is updated only at the time of a software release.

Advantages of PDF Documentation

PDFs can be more easily printed, archived, and transferred (such as by FTP or email) than HTML
documentation.

For more information, see Downloading Files and Sharing Links from the Documentation Library in the
Documentation Library.

Opening the Documentation Library
To open the AgilePoint Documentation Library, do the following.

Prerequisites

You must have a valid account on the AgilePoint Support Portal.

Instructions

1. Log on to the AgilePoint Support Portal.

2. Click Documentation.

3. On the Documentation page, click the documentation library for your AgilePoint release.

• For AgilePoint BPMS v5.0 SP1 and higher, the web-based documentation library opens in a new tab or
window in your web browser.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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• For releases prior to v5.0 SP1, a download starts for a Zip file with the PDF documentation for your
release.

Finding Information in the Documentation Library
The information in this topic will help you to locate information in the AgilePoint Documentation Library.

Using the Table of Contents

The table of contents in the AgilePoint Documentation Library is divided by content areas. For example, the
Installation section includes all the information you need to install AgilePoint BPMS. The AgilePoint API section
includes information about the AgilePoint APIs.

You can use the Table of Contents to explore the AgilePoint documentation content and find the information you
want.

Searching

The web-based documentation includes a centralized search for all documentation content. To search for
information:

1. In the AgilePoint Documentation Library, click the Search tab. In the Search box, enter 1 search team, and
click Search.

The search results display in alphabetical order by topic title.

It is important to understand that the third-party software AgilePoint uses to generate web-based
documentation allows only 1 search term. More than 1 search term will cause the search to fail.

AgilePoint recommends using a relatively unique search term to find the information you need. For example,
entering a common term, such as "process," will return a high percentage of the total documentation topics
in the search results.

2. Browse the list of topic titles to find the information you want.

Printing

The PDF documentation is provided mainly for the purpose of printing and archiving. To print a set of
information:

1. Navigate to the main page of the Documentation Library from which you want to print.

2. In the list of documents, click the document name in the PDF column.

3. From your PDF reader software, print the portion of the document you want.

Downloading Files and Sharing Links from the
Documentation Library
You can download and share files AgilePoint's documentation library as you would in any other web page. Note
that if you send links to recipients, they must have a Support Portal login to view the file.

These procedures are common examples based on Internet Explorer with the Adobe Reader plug-in. Exact
procedures may vary depending on your web browser, PDF viewer, and email client configuration.
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Share a Link to an HTML Topic

1. Navigate to the topic you want to share.

2. Copy the URL in the Location box in your web browser.

3. Paste the URL in an email, IM client, etc.

Share a Link to a PDF Document

1. In Internet Explorer, navigate to the Documentation Library home page.

2. In the PDF column, right-click the name of the PDF file you want to share.

3. In the quick menu, click Copy shortcut.

4. Paste the URL in an email, IM client, etc.

Save a Copy of a PDF Document

1. In Internet Explorer, open the Documentation Library home page.

2. In the PDF column, click the name of the PDF file you want to share.

3. In the Adobe Reader plug-in, click Save button.

Contacting AgilePoint Sales
AgilePoint is a leading Business Process Management System (BPMS) provider created by a team of driven
people who strive to incorporate the principles of relentless innovation for the benefit of our customers. Our
mission is to help companies of any size attain and sustain operational success through process excellence.

Headquarters: AgilePoint Corporation 1916C Old Middlefield Way Mountain View, CA 94043, USA

Tel: (650) 968 - 6789

Fax: (650) 968 - 6785

Email: info@agilepoint.com

Web site: www.agilepoint.com

International: For AgilePoint EMEA and AgilePoint Asia Pacific, please call the AgilePoint Corporate Office for
contact information.

  

Contacting Customer Support
To contact AgilePoint Support, please submit a ticket on the AgilePoint Support Portal: http://
support.agilepoint.com/SupportPortal/

If you do not have a Support Portal account, you can send an email to request one: support@agilepoint.com

mailto:info@agilepoint.com
http://www.agilepoint.com
http://support.agilepoint.com/SupportPortal/
http://support.agilepoint.com/SupportPortal/
mailto:support@agilepoint.com


SharePoint Integration 9

AgilePoint BPMS v5.0 R2 SharePoint Integration Guide r5.3.12

SharePoint Integration
This document describes the SharePoint Integration component of the AgilePoint BPMS Suite.

What Is AgilePoint Integration for SharePoint?

AgilePoint for SharePoint is a powerful integration tool that extends AgilePoint's enterprise-class BPM solution to
SharePoint. At the same time, AgilePoint for SharePoint maintains a clean separation that minimizes impact on
the SharePoint environment and its performance specifications like stability, upgradeability and usability.

What can AgilePoint Integration for SharePoint Do for You?

AgilePoint for SharePoint lets you realize the true potential of a SharePoint-empowered work environment. With
AgilePoint for SharePoint, SharePoint can be used to enable departmental level self-sufficiency, create and
maintain workflows and coordinate your enterprise-level business critical processes.
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Configuring the AgilePoint SharePoint
Integration AgileConnector
This AgilePoint Server extension (AgileConnector) allows for the communication between AgilePoint Server and
SharePoint. This extension is only applicable for the AgilePoint SharePoint Integration v2.

Prerequisites

• AgilePoint Server is installed.

• The credentials for the SharePoint Impersonator account.

The SharePoint Impersonator account is determined during pre-installation. For more information, see
Creating a SharePoint Impersonator User Account in the Documentation Library.

Navigation

1. On the AgilePoint Server machine, click Start > All Programs > AgilePoint > AgilePoint Configuration.

2. On the  AgilePoint Server Configuration Tool  window, click the Extensions tab.

Instructions

1. On the Extension tab, click on Add.

2. Browse one of the following locations to open the file Ascentn.SharePoint.AgileConnector.dll:

• For IIS installations, this file is located in the bin folder under the AgilePoint Server installation folder.

• For Windows Service installations, this file is located in the bin folder under the path provided in the
Location field in Windows Server Manager for the Windows Service instance you want to configure.

3. Change the Name from AgileConnector to SPSIntegration.

4. Enter the Impersonator (e.g. Administrator).

5. Click OK.

6. Optionally, you can click Configure to set the maximum thread for SharePoint access and to set the
credential for SharePoint access. By default it will use the AgilePoint System User Account credential.

7. When you have finished the configuration, on the AgilePoint Configuration window, click OK.

Accept any informational messages.

If you are prompted to restart IIS or the AgilePoint Service, click Yes.

Configuring the SharePoint Integration AgileConnector
To configure the SPSIntegration extension, do the following.

Prerequisites

• If you are using Forms Based Authentication, set this up in your SharePoint environment using the
instructions from Microsoft: http://msdn.microsoft.com/en-us/library/bb975136%28v=office.12%29.aspx

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://msdn.microsoft.com/en-us/library/bb975136%28v=office.12%29.aspx
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Navigation

1. On the AgilePoint Server machine, click Start > All Programs > AgilePoint > AgilePoint Configuration.

2. On the  AgilePoint Server Configuration Tool  window, click the Extensions tab.

3. On the Extensions tab, select SPSIntegration.

4. Click Configure.

Instructions

1. On the AgileConnector for SharePoint window, configure the following fields as required for your
environment, and then click OK.

Field Name Definition

Max Threads for SharePoint Access Definition:

Specifies the maximum number of concurrent
connections between AgilePoint Server and
SharePoint.

Allowed Values:

Any integer.

Default Value:

10

Windows Authentication Definition:

Specifies whether, and what type, of Windows
Authentication is used to connect to SharePoint.

Claims Authentication
Definition:

Specifies whether to use Claims authentication,
and what type of Claims authentication, to use to
connect to SharePoint.

Allowed Values:

If this option is selected, the following types of
Claims Authentication are available:

• Form Based Authentication - Activates
Forms based authentication using a custom
membership provider to connect to an on-
premises SharePoint environment.

• Office 365 - Activates Claims authentication
to connect to SharePoint in an Office 365
environment. This option can be used side-by-
side with on-premises SharePoint.
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Field Name Definition

• Federated Authentication - Activates
Federated authentication to connect to
SharePoint -- for example, ADFS.

Note:  Out of the box, AgilePoint
supports ADFS authentication. If you
want to use your own authentication
provider, see Federated Authentication
Example in the Documentation Library.

Default Value:

Deselected

Domain Definition:

The authentication domain.

This does not apply to Forms-Based Authentication.

Username The user ID of the SharePoint authentication account.

Password Definition:

The password for the authentication account.

Allowed Values:

A valid password.

Default Value:

None

Custom Attributes:

Yes

Fed Auth Url Definition:

The URI of the federated authentication provider.
This provider issues security tokens for federated
authentication.

Allowed Values:

A valid federated authentication provider URI.

Default Value:

None

Custom Attributes:

No

Example:

https://fs.agilityclouds.com

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Field Name Definition

Use UTF8 Encoding Definition:

Specifies whether to use UTF-8 encoding when
communicating with the external system.

Allowed Values:

• Selected - Specifies to use UTF-8 encoding.

• Deselected - Specifies not to use UTF-8
encoding.

Default Value:

Deselected

Send Notification for Suspended Processes Definition:

Specifies whether the SPSIntegration
AgileConnector sends a notification to the
AgilePoint system administrator if a process
instances is suspended as a result of a SharePoint
Integration error.

Allowed Values:

• Deselected - No email notification is sent.

• Selected - Sends an email notification if a
process instance is suspended.

Default Value:

Deselected
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Set up a Common AgilePoint Configuration List
for Multiple Site Collections

Note:  This configuration step is optional. If you do not complete this step, the current system behavior
will remain the same, and the functionality of your AgilePoint system will be unaffected.

By default, each SharePoint site collection has its own AgilePoint Configuration List. This is recommended
because it allows you the capability of connecting to different AgilePoint Servers for different SharePoint Site
Collections in future. Also, things like different log folders for different SharePoint Site Collections for better
tracking would be available.

In a case where you have many SharePoint Site Collections within the same SharePoint Web application and
you do not want to maintain the configuration list separately, and all site collections are going to connect to same
AgilePoint Server, you can define one common AgilePoint Configuration List in the SharePoint Web Application
web.config file.

Prerequisites

• AgilePoint Integration for SharePoint is fully installed.

Navigation

1. Navigate to SharePoint Central Administration on your SharePoint site.

2. In a text editor, open the SharePoint Web Application web.config file.

Instructions

1. In the SharePoint web.config, add the following key/value nodes:

<appSettings>
    <add key="APSettingsListName" value="AgilePoint Configuration" />
    <add key="APSettingsSiteUrl" value="[ShrePoint Site URL]" />
    <add key="APSettingsWebName" value="" />
</appSettings>

Use the following values:

• APSettingsListName - The name of the AgilePoint Settings List.

• APSettingsSiteURL - The SharePoint Site URL that contains the common AgilePoint Configuration
List. The rest of the site collections will refer to this location and list as long as the individual AgilePoint
Configuration list (which is auto-created in the site collection when this feature is activated) is
deactivated or removed.

• APSettingsWebName - If this field is left blank, this means that the AgilePoint Configuration List is
located at the top-level site. A value would indicate the Sub site name.
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Add the AgilePoint Web Parts to SharePoint
To access the features of the AgilePoint SharePoint Integration, you must add the AgilePoint Web Parts to your
SharePoint site. AgilePoint Web Parts are added in the same manner as other SharePoint Web Parts.

Prerequisites

• AgilePoint Integration for SharePoint is fully installed.

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the site page where you want to add the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Click Add a Web Part.

2. In the Categories pane, click AgilePoint.

3. In the Web Parts pane, click the Web Part you want.

• AgilePoint Process Instance List – Includes the list of running process instances.

• AgilePoint Process Model List – Displays all process models that are deployed to AgilePoint Server.

• AgilePoint Task List – Includes the AgilePoint Task List that provides a way for users to manage their
tasks.

4. Click Add.
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AgilePoint Web Parts
This section is a user's guide and reference to the features, functionality, usage, configuration, and
administration of the Web Parts that are included with the AgilePoint SharePoint Integration component of the
AgilePoint BPMS Suite.

AgilePoint Task List Web Part
The AgilePoint Task List Web Part displays any process tasks assigned to the user viewing the SharePoint site,
and provides tools for managing those tasks.

Navigation

1. In SharePoint, navigate to the Task List Web Part.

Field Definitions

Field Name Definition

Refresh Function:

Refreshes the Web Part window's content. Use this
button to manually refresh the Web Part window's
content to see if changes have occurred.
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Field Name Definition

Filter Function:

Displays the Web Part's content based on the
values entered.

When you click the Filter button, a section is
displayed with all Web Part fields. In the fields list,
select the appropriate values to set the filter criteria
to display the required Web Part's content.

For example, in the Template list, if you select
Budget Request, only the tasks related to Budget
Request template are displayed.

Sort By Definition:

Arranges the Web Part window's content based on
the field name you selected.

Allowed Values:

The field name you want.

Default Value:

None

Group By Definition:

Specifies the field name you want to group the Web
Part window's content.

Allowed Values:

The name of your field.

Default Value:

None

Global Actions Definition:

Specifies an action to be performed on all selected
tasks at once.

Allowed Values:

• Reassign Selected Tasks - Reassigns the
selected tasks to another participant.

• Cancel Selected Tasks - Cancels the selected
tasks.

• Take Assignment for Selected Tasks -
Assigns the selected tasks to you.

Default Value:

None
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Field Name Definition

Priority Definition:

Specifies the importance of a task.

Allowed Values:

Read only.

• Red icon - Indicates a high priority task.

• Green icon - Indicates a normal priority task.

• Yellow icon - Indicates a low priority task.

Template Definition:

Specifies the name of the AgilePoint process
template.

Allowed Values:

Read only.

Process Name Definition:

Displays the unique process instance name.

Allowed Values:

Read only.

Task Definition:

Specifies an operation to perform on an assigned
task.

Allowed Values:

Not all possible values are available for every
user. It depends on your settings and the user
permissions.

• View Process - Opens the process in the
Process Viewer.

• Change Priority - Changes the priority of the
task.

• Open [work to perform] - Opens the form
or view associated with the WorkToPerform
property.

• Complete Task - Completes the task and
moves the process forward. The Wait Work
Performed property for the task must be set to
False.

• Take Assignment - Assigns the task to you.

This is applicable only when the task is
assigned to a pool of users.
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Field Name Definition

• Take Assignment and Complete [work
to perform] - Assigns the task to you, and
completes it.

• Take Assignment and Open [work to
perform] - Assigns the task to you, and opens
the task.

• Release to Pool - Releases the assigned task
for another user in the pool to take assignment.

This is applicable only when the task is
assigned to a pool of users.

• Cancel Task - Cancels the task.

• Cancel Process - Cancels the process.

• Reassign - Reassigns the task to any other
user.

• Task Rework - Initiates a partial rework of any
task that has already been completed.

• Create Linked Work Item - Creates tasks for
other participants in ad-hoc manner.

• View Description - Displays content of the
Description parameter of the activity as defined
in Envision.

• View Conversation - Opens a conversation
related to the task in Yammer, if applicable.

• Goto Source - Opens the source library where
the task is stored.

Default Value:

None

Assigned To Definition:

Displays the participant to whom the task is
assigned.

Allowed Values:

Read only.

Assigned Date Definition:

Displays the date and time the task was assigned to
the participant.

Allowed Values:

Read only.

Department Definition:
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Field Name Definition

Displays the participant's department.

Allowed Values:

Read only.

Due Date Definition:

Displays the date and time the task is due to be
completed.

Allowed Values:

Read only.

Configuration Options - Task List Web Part
Sets up the SharePoint Task List Web Part.
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Navigation

1. In SharePoint, navigate to the Task List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Field Definitions

Field Name Definition

Type of List Definition:

Determines the scope of the tasks you want to
display in the Task List Web Part.

Note:  Except for the default Tasks option,
all options listed here have the potential to
download a large amount of data, which
can slow SharePoint performance. These
options are recommended only in views or
pages created for managers. They are not
recommended for other users.

Allowed Values:

• Tasks - Displays your tasks only.

• MyDirectTeam - Displays your tasks, plus the
tasks for any users for whom you are listed as
the Manager in AgilePoint Enterprise Manager.

• MyTeamAndSub - Displays tasks for you, the
members of your direct team, and the members
of their direct teams. This is typically used by
higher level managers.

• MyDepartment - Displays your tasks and the
tasks for everyone in your department.

• MyGroup - Displays your tasks and the tasks
for all members of groups for which you are the
group leader in Enterprise Manager.

• MyGroupPeers - Displays your tasks and the
tasks for all members of all groups for which
you are a member.

• AllTasks - Display all the tasks for all users
within the AgilePoint BPMS system.

Default Value:

Tasks
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Field Name Definition

Templates Definition:

Specifies process templates the Web Part uses to
filter process instances.

Allowed Values:

One or more process template names.

You can enter multiple process template names,
separated by semicolons (;).

Default Value:

None

Groups Definition:

Limits the display of tasks. Only the tasks of the
specified list of groups are displayed.

Allowed Values:

The name of your group.

You can separate groups using semicolons.

Default Value:

None

Departments Definition:

Limits the display of tasks. Only the tasks of the
specified list of departments are displayed.

Allowed Values:

The name of your department.

You can separate departments using semicolons.

Default Value:

None

SharePoint Fields Definition:

Allows to display the context data of a process
instance.

To perform this, you must first publish context data
into the SharePoint library using metadata fields,
and then type a semicolon-separated list of column
names.

Allowed Values:

The name of your SharePoint fields.

You can separate list of columns using semicolons.
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Field Name Definition

Default Value:

None

Show "Complete Selected Tasks" in Global Actions Definition:

Determines whether to display the Complete
Selected Tasks option in the Global Actions list that
enables the user to complete a number of selected
tasks at once.

Allowed Values:

• Deselected - Specifies not to display the
Complete Selected Tasks option in the Global
Actions list.

• Selected - Specifies to display the Complete
Selected Tasks option in the Global Actions list.

Default Value:

Deselected

Show Multiple Dynamic Group/Roles Definition:

Determines whether to disable querying against
multiple dynamic groups or roles if a Web Part
performance is slow.

The reason is that some organizations experience
slow performance while querying against multiple
dynamic groups or roles. You can deselect this
option to enhance the Web Part performance.
The tasks for the dynamic groups or roles are not
displayed in the Web Part.

This setting is optional. Not all organizations
experience this issue, and deselecting this option
results in reduced functionality.

Allowed Values:

• Selected - Specifies to execute queries against
multiple dynamic groups or roles.

• Deselected - Specifies not to execute queries
against multiple dynamic groups or roles.

Default Value:

Selected

Open task by clicking the task link Definition:

Determines whether to enable a user to open a task
by clicking the hyperlinked task name.

Allowed Values:
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Field Name Definition

• Deselected - Specifies not to open a task by
clicking the hyperlinked task name.

• Selected - Specifies to open a task by clicking
the hyperlinked task name.

Default Value:

Deselected

Show Overdue Task in Color Definition:

Determines whether the Web Part displays overdue
tasks with a different color.

Allowed Values:

• Deselected - Disables displaying overdue tasks
with a different color.

• Selected - Enables displaying overdue tasks
with a different color.

Default Value:

Deselected

Color for Overdue Tasks Definition:

Specifies to choose a color from the list to mark
overdue tasks.

Allowed Values:

The color you want.

Default Value:

Red

Color for Selected Task Definition:

Specifies to choose a color from the list to set the
background color for the selected tasks.

Selected tasks are marked when the ID of tasks is
passed using the http query string parameters. This
is also applied while sending emails to include a link
to task:

http://mysite/default.aspx?WID=[WorkItemID]

Allowed Values:

The color you want.

Default Value:

LightBlue
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Field Name Definition

Color for Tasks on Pool Definition:

Specifies to choose a color from the list to set the
background color for tasks that are assigned to a
pool.

Allowed Values:

The color you want.

Default Value:

LightYellow

Items Per Page Definition:

Specifies the number of items to display on one
page in the Web Part.

Allowed Values:

An integer.

Default Value:

10

Max. Tasks to Retrieve Definition:

Limits the number of tasks to be retrieved. Limiting
the number of tasks to retrieve can help improve
performance.

Allowed Values:

An integer.

If you are using columns that retrieve data from
Custom Data Sources, AgilePoint recommends
limiting this number to 50 or lower.

Default Value:

500

AgilePoint Columns Function:

Enables you to show or hide columns on the Web
Part and set the display name for columns.

Apply Filter Definition:

Specifies whether to filter items in the Task List
Web Part based on column values.

The value in the Filter Condition field performs
actual filtering operation.

Allowed Values:
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Field Name Definition

• Deselected - Specifies not to filter items int the
Task List.

• Selected - Enables filtering for the Task List
using the Filter Condition field.

This option may adversely affect the Task List
performance.

Default Value:

Deselected

Filter Condition Function:

Sets the filter criteria that defines which SharePoint
list data to be retrieved.

Allowed Values:

A valid SQL query.

For more information, see Filtering the SharePoint
Task List in the Documentation Library

Default Value:

None

Example:

For more information, see Filtering the SharePoint
Task List in the Documentation Library

Pre-Processing Custom Filter Definition:

Specifies whether pre-processing custom filter is
enabled on the task list. This option enables you to
filter Task List results before they are processed by
the Task List Web Part in order to improve Task List
performance.

This advanced option supersedes the Apply Filter
field used for standard Task List filtering.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Allowed Values:

• Deselected - Specifies not to apply any filter
condition.

• Selected - Enables the pre-processing filter
condition option.

Default Value:

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Field Name Definition

Deselected

Data Population DataBase Definition:

Specifies the name of your data population
database.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Allowed Values:

The name of your data population database.

Default Value:

None

Example:

MyDatabase

Query Definition:

Specifies a query to retrieve Task List data from the
Data Population database before filtering it with the
Filter Condition.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Click the Ellipses button to open an editor window
to set the query condition in the field.

Allowed Values:

A SQL query in the following format:

SELECT [process instance ID] FROM <data
population table> WHERE <condition>

• [process instance ID] - The name of the
column in the population table to which process
instance id is mapped in data population
configuration. The square brackets [ ] are literal,
and are required.

• <data population table> - The name of your
data population database table. Do not include
the angle brackets < >

• <condition> - Your SQL condition. The left
side of the condition statement is the name of
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Field Name Definition

the database column you want to filter. Do not
include the angle brackets < >

Example:

SELECT [ProcessId] FROM PopulationTable
WHERE UserRole='Manager'

Filtering the SharePoint Task List
Use the instructions in this section to filter tasks in the SharePoint Task List web part by column. String and
DateTime columns can be filtered based on values or partial values, using the following operators.

Prerequisites

• AgilePoint SharePoint Integration.

• An AgilePoint release that includes FIX 06.0082.04. For more information, see the AgilePoint Intermediate
Fixes document.

Good to Know

• Most of the following examples show examples for the out of the box Task List columns. However, the same
format applies to columns from custom data sources.

• For errors, see FilterInTaskList in the AgilePoint logs.

Navigation

1. In SharePoint, navigate to the Task List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Instructions

1. In the Web Part configuration options, select Apply Filter.

2. In the Filter Condition field, enter a SQL query with a condition based on the data type of the column you
want to filter. See the tables in this topic for examples.

Filter Operators for String Type Columns

Operator Symbol Examples

Equal to = • Priority='Low'

• Template='TemplateName'

• Process
Name='ProcInstanceName'



AgilePoint Web Parts 29

AgilePoint BPMS v5.0 R2 SharePoint Integration Guide r5.3.12

Operator Symbol Examples

• Task='TaskName'

• Assigned
To='AssignedUserName'

• Department='Department'

• Status='Overdue'

Not equal to <> • Priority<>'Low'

• Template<>'TemplateName'

• Process
Name<>'ProcInstanceName'

• Task<>'TaskName'

• Assigned
To<>'AssignedUserName'

• Department<>'Department'

• Status<>'Overdue'

Like Like'...*' • Priority Like 'Lo*'

• Template Like 'TemplateNam*'

• Process Name Like
'ProcInstanceNam*'

• Task Like 'TaskNam*'

• Assigned To Like
'AssignedUserNam*'

• Department Like 'Departmen*'

• Status Like 'Overdue*'

Not like Not Like'*...' • Priority Not Like '*ow'

• Template Not Like
'*emplateName'

• Process Name Not Like
'*rocInstanceName'

• Task Not Like '*askName'

• Assigned To Not Like
'*ssignedUserName'

• Department Not Like
'*epartment'

• Status Not Like '*verdue'
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Filter Operators for DateTime Type Columns

Operator Symbol Examples Comments

Like Like'...*' • Assigned Date
Like 'YYYY-MM-
DDTHH:MM:SS*'

• Due Date Like'YYYY-
MM-DDTHH:MM:SS*'

Not like Not Like'*...' • Assigned Date Not
Like 'YYYY-MM-
DDTHH:MM:SS*'

• Due Date Not
Like 'YYYY-MM-
DDTHH:MM:SS*'

• The DateTime value
format is "YYYY-MM-
DDTHH:MM:SS",
strict.

• Hour (HH) is in 24 hr
format

Greater than > • Assigned Date
> #YYYY-MM-
DDTHH:MM:SS#

• Due Date > #YYYY-
MM-DDTHH:MM:SS#

Less than < • Assigned Date
< #YYYY-MM-
DDTHH:MM:SS#

• Due Date < #YYYY-
MM-DDTHH:MM:SS#

Greater than or equal to > • Assigned Date
>= #YYYY-MM-
DDTHH:MM:SS#

• Due Date >= #YYYY-
MM-DDTHH:MM:SS#

Less than or equal to <= • Assigned Date
<= #YYYY-MM-
DDTHH:MM:SS#

• Due Date <= #YYYY-
MM-DDTHH:MM:SS#

Last n days >${[Now,-[n]} • Assigned Date >
${[Now,-5}

• Due Date >${[Now,-5}

You can replace 5 in
the example to specify a
different number of days,
such as >${[Now,-10}
for the last 10 days. The
formatting displayed in
these examples is strict.



AgilePoint Web Parts 31

AgilePoint BPMS v5.0 R2 SharePoint Integration Guide r5.3.12

Filters for Multiple Columns

Operator Symbol Examples

And And • Employee Name='EmpName'
And Employee DOJ > #YYYY-
MM-DDTHH:MM:SS#

Or Or • Employee Name='EmpName'
Or Employee DOJ > #YYYY-
MM-DDTHH:MM:SS#

Nested statements () • (Employee Name='EmpName'
And Employee DOJ > #YYYY-
MM-DDTHH:MM:SS#) Or
(Assigned Date >${[Now],-5}||
Due Date >${[Now],-5})

Setting Up Database-Side Filtering (Pre-Processing) on the SharePoint
Task List Web Part
In the narrow set of circumstances described in the Prerequisites and Good to Know sections of this topic, you
may want to filter custom data columns using a direct SQL query on the database, instead of using the standard
Task List Filter option. This advanced feature, called Pre-Processing the Task List filter, improves performance,
but it requires creating a SQL query directly to your database.

If you want to perform database-side filtering on the Task List, do the following.

Prerequisites

• AgilePoint SharePoint Integration.

• You are filtering the Task List based on custom data columns.

For more information, see Filtering the SharePoint Task List in the Documentation Library

• Custom data sources are set up for the Web Part.

For more information, see Custom Data Sources Configuration Window in the Documentation Library

• Data population is configured for the custom attributes on which you want to apply pre-processing for the
Task List filter. In other words, the custom attributes you want to filter must exist in your Data Population
database table.

For more information, see Setting Up Data Population in the Documentation Library

• An AgilePoint release that includes FIX 06.0108.01. For more information, see the AgilePoint Intermediate
Fixes document.

Good to Know

• If you use this feature, it supersedes task list filtering using the Apply Filter and Filter Condition fields used in
the standard Task List Filtering.

For more information, see Filtering the SharePoint Task List in the Documentation Library

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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• This feature is best used when you are retrieving more than 500 tasks in the Task List Web Part. Otherwise,
the performance benefit may not be required.

Navigation

1. In SharePoint, navigate to the Task List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Instructions

1. In the Web Part Configuration options, enter the values in the following fields as required:

Field Name Definition

Pre-Processing Custom Filter Definition:

Specifies whether pre-processing custom filter is
enabled on the task list. This option enables you to
filter Task List results before they are processed by
the Task List Web Part in order to improve Task List
performance.

This advanced option supersedes the Apply Filter
field used for standard Task List filtering.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Allowed Values:

• Deselected - Specifies not to apply any filter
condition.

• Selected - Enables the pre-processing filter
condition option.

Default Value:

Deselected

Data Population DataBase Definition:

Specifies the name of your data population
database.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Allowed Values:
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Field Name Definition

The name of your data population database.

Default Value:

None

Example:

MyDatabase

Query Definition:

Specifies a query to retrieve Task List data from the
Data Population database before filtering it with the
Filter Condition.

Note:  This advanced option is required
only if you want to perform pre-processing
for filtering custom data columns. This is an
uncommon situation.

Click the Ellipses button to open an editor window
to set the query condition in the field.

Allowed Values:

A SQL query in the following format:

SELECT [process instance ID] FROM <data
population table> WHERE <condition>

• [process instance ID] - The name of the
column in the population table to which process
instance id is mapped in data population
configuration. The square brackets [ ] are literal,
and are required.

• <data population table> - The name of your
data population database table. Do not include
the angle brackets < >

• <condition> - Your SQL condition. The left
side of the condition statement is the name of
the database column you want to filter. Do not
include the angle brackets < >

Example:

SELECT [ProcessId] FROM PopulationTable
WHERE UserRole='Manager'

Hiding Menu Options in the SharePoint Task List
You can hide options in the SharePoint Task List menu. This is the drop-down menu associated with a task in
the Task List. To hide menu options in the SharePoint Task List, do the following.
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Prerequisites

• AgilePoint SharePoint Integration.

• SharePoint Task List installed.

Navigation

1. In SharePoint, navigate to the Task List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In Data View Properties, click AgilePoint Columns.

4. In the Hide TaskList Action Menu Entry field, click the Ellipses button.

Instructions

1. In the Text Editor window, enter the menu item names that you do not want to display.

You must enter the names exactly as they appear in the task menu.

You can enter more than one name, separated by semicolons (;) — for example, View Process;Cancel
Process.

Adding the Task List Web Part to SharePoint
The AgilePoint Task List Web Part for SharePoint can be placed in various locations in SharePoint. To add the
AgilePoint Task List Web Part to SharePoint, do the following.

Prerequisites

• The AgilePoint Task List Web Part interacts with one or more servers － for example, AgilePoint,
SharePoint, and/or database servers － whenever they are viewed or refreshed. This interaction is
necessary and unavoidable in most cases, and is part of the AgilePoint system's expected usage patterns.

• In some environments, the location for which the AgilePoint Task List Web Part is placed may have
unintended effects on the system's performance. For example, in an environment where there are many
thousands of SharePoint users, but only a fraction of those users interact with AgilePoint, placing the
AgilePoint Task List control on an entry or Top Level site page that is frequently accessed by the entire
group of SharePoint users may place additional unnecessary load on the AgilePoint system when the page
is accessed by users that don't need access to the Web Part.

In such a scenario, it may be better to place the Web Part on a sub site location that is only accessed by a
more appropriate group of AgilePoint users and/or that is only accessed when necessary.

You can notice errors being written to the AgilePoint Event Logs in the Event Viewer when a SharePoint site
is being accessed that includes the AgilePoint Task List Web Part by a non-registered AgilePoint user.

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.
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Navigation

1. In SharePoint, navigate to the site page where you want to add the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Click Add a Web Part.

2. In the Categories pane, click AgilePoint.

3. In the Web Parts pane, click AgilePoint Task List.

4. Click Add.

Removing an AgilePoint Web Part from SharePoint
To remove an AgilePoint Web Part from SharePoint, do the following.

Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the site page where you want to remove the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Move the pointer over the Web Part you want to remove from the site page, and then click the Web Part
arrow to display the list. The Arrow button appears only when you move the pointer over the Web Part
window.

2. In the list, click Delete.

Showing Tasks from other Virtual Servers (MOSS Web
Applications)
The AgilePoint Task List Web Part supports the ability to show tasks from multiple Virtual Servers (MOSS Web
Applications).  A SharePoint registry configuration is required to enable this feature.

1. Access the registry for the SharePoint machine.

2. For the ShowCrossVSTask registry entry, set the Value data field to 1. This allows tasks from multiple
Virtual Servers (MOSS Applications) to show in the AgilePoint Task List.
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Showing External AgilePoint Web Application Tasks
AgilePoint provides a powerful feature that allows users to include external AgilePoint Web application tasks
in the AgilePoint Task List Web Part for SharePoint. Each process model in AgilePoint Envision has an
associated "Application" name (as shown below). This name is configurable from AgilePoint Envision when the
process model is open and no shapes or lines are selected. It will appear in the Property List in the Advanced.

You can use either the Manual or WebForm AgileWork to implement the Web application tasks.

To include external Web application tasks in the AgilePoint Task List Web Part for SharePoint:

1. Choose the Generic process model type, and change the Application name to something like
MyASPNETApplication. Where MyASPNETApplication is the name of your Web application.

The following process model template types can be used to implement the Web application tasks (i.e.
Generic, Microsoft SPDoc, Microsoft SPList).

Note:  A list entry is required for each Web application.

2. Add a new SharePoint List Item in the AgilePoint Configuration List. Open the AgilePoint Configuration
List for the Site Collection and click New > AgilePoint Config Setting Item. The New Item page appears.

3. In the Application field, type AgilePointASPAssociation. This is a constant.

4. In the AP Setting Key field, type the name of your Web application.

5. In the AP Setting Value field, type the URL to the Web application.

6. In the Description field, enter a description about the Web application.

7. Click the Encrypted check box if you would like to encrypt the AP Setting Value.

8. Click OK. The Web application pages will now be served to the user based on your Manual activity Work to
Perform property (e.g. Review).

AgilePoint Process Instance List Web Part
The AgilePoint Process Instance List displays all running process instances. You can filter, sort, and group to
display the required process instances.
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Navigation

1. In SharePoint, navigate to the Process Instance List Web Part.

Field Definitions

Field Name Definition

Refresh Function:

Refreshes the Web Part window's content. Use this
button to manually refresh the Web Part window's
content to see if changes have occurred.

Filter Function:

Displays the Web Part's content based on the
values entered.

When you click the Filter button, a section is
displayed with all Web Part fields. In the fields list,
select the appropriate values to set the filter criteria
to display the required Web Part's content.

For example, in the Template list, if you select
Budget Request, only the tasks related to Budget
Request template are displayed.

Sort By Definition:

Arranges the Web Part window's content based on
the field name you selected.
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Field Name Definition

Allowed Values:

The field name you want.

Default Value:

None

Group By Definition:

Specifies the field name you want to group the Web
Part window's content.

Allowed Values:

The name of your field.

Default Value:

None

Global Actions Definition:

Specifies an action to be performed on all selected
process instances at once.

Allowed Values:

• Cancel Selected Processes - Cancels the
selected running process instances.

Default Value:

None

Template Definition:

Specifies the name of the AgilePoint process
template.

Allowed Values:

Read only.

Process Name Definition:

Displays the unique process instance name.

Allowed Values:

Read only.

However, if you click the process name, the Web
Part displays a list of the following actions that can
be performed on the selected process:

• View Process - Opens the Process Viewer that
displays the current status of the process.
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Field Name Definition

• Cancel Process - Cancels the process. This
option is available only when user has the
privilege to cancel a process.

• Go To Source - Opens the source SharePoint
list or document library.

• Go To link Item - Opens the source SharePoint
list or document library item.

Status Definition:

Displays the status of the task.

Allowed Values:

Read only.

Started Date Definition:

Displays the date the work item started.

Allowed Values:

Read only.

Process Initiator Definition:

Specifies the user name who initiated the process.

Allowed Values:

Read only.

Configuration Options - Process Instance List Web Part
Allows to configure the SharePoint Process Instance List Web Part.
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Navigation

1. In SharePoint, navigate to the Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Field Definitions

Field Name Definition

Type of List Definition:

Determines what process instances to be retrieved.

Allowed Values:

• AllProcesses - All process instances are
retrieved.
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Field Name Definition

• MyInitiatedProcesses - The process instances
initiated by the user are retrieved. This indicates
that the ProcessInitiator is me.

• MyInvolvedProcesses - The process instances
that have some tasks assigned to the user are
retrieved.

Default Value:

MyInitiatedProcesses

SharePoint Fields Definition:

Allows to display the context data of a process
instance.

To perform this, you must first publish context data
into the SharePoint library using metadata fields,
and then type a semicolon-separated list of column
names.

Allowed Values:

The name of your SharePoint fields.

You can separate list of columns using semicolons.

Default Value:

None

Templates Definition:

Specifies process templates the Web Part uses to
filter process instances.

Allowed Values:

One or more process template names.

You can enter multiple process template names,
separated by semicolons (;).

Default Value:

None

Items Per Page Definition:

Specifies the number of items to display on one
page in the Web Part.

Allowed Values:

An integer.

Default Value:

10
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Field Name Definition

Max. Process Instances to Retrieve Definition:

Limits the number of process instances to be
retrieved for display in the Web Part. Limiting the
number of process instances to retrieve can help
improve performance.

This filter is applied before any other filters on the
Web Part. Therefore, any additional filters on the
Web Part results are applied only to the results
limited by this setting.

Allowed Values:

An integer.

Default Value:

500

Adding the Process Instance List Web Part to SharePoint
To add the AgilePoint Process Instance List Web part to SharePoint, do the following.

Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the site page where you want to add the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Click Add a Web Part.

2. In the Categories pane, click AgilePoint.

3. In the Web Parts pane, click AgilePoint Process Instance List.

4. Click Add.

Removing an AgilePoint Web Part from SharePoint
To remove an AgilePoint Web Part from SharePoint, do the following.

Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.
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Navigation

1. In SharePoint, navigate to the site page where you want to remove the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Move the pointer over the Web Part you want to remove from the site page, and then click the Web Part
arrow to display the list. The Arrow button appears only when you move the pointer over the Web Part
window.

2. In the list, click Delete.

Using the Process Instance List Web Part
By clicking on process name, the Web Part will show a menu with actions that the user can perform (e.g. if the
user has privileges to cancel a process, this action will be available).

There is also a Go to Source action that opens the Form/Document library. You can perform some global actions
over one or more process instances by checking the check boxes on the left and clicking on Global Actions.

Performing Global Actions
You can perform global actions over one or more process instances. For example, you can cancel the selected
running process instances all at once. Do the following.

Navigation

1. In SharePoint, navigate to the Process Instance List Web Part.

Instructions

1. To cancel the running process instances all at once, select the check boxes on the left for the process
instances you want.

2. Click Global Actions, and then select Cancel Selected Processes.

AgilePoint Process Model List Window
The AgilePoint Process Template List displays all process templates deployed on the AgilePoint Server.
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Navigation

1. In SharePoint, navigate to the Process Model List Web Part.

Field Definitions

Field Name Definition

Refresh Function:

Refreshes the Web Part window's content. Use this
button to manually refresh the Web Part window's
content to see if changes have occurred.

Filter Function:

Displays the Web Part's content based on the
values entered.

When you click the Filter button, a section is
displayed with all Web Part fields. In the fields list,
select the appropriate values to set the filter criteria
to display the required Web Part's content.

For example, in the Template list, if you select
Budget Request, only the tasks related to Budget
Request template are displayed.

Sort By Definition:

Arranges the Web Part window's content based on
the field name you selected.

Allowed Values:

The field name you want.

Default Value:

None

Group By Definition:
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Field Name Definition

Specifies the field name you want to group the Web
Part window's content.

Allowed Values:

The name of your field.

Default Value:

None

Template Definition:

Specifies the name of the AgilePoint process
template deployed on the AgilePoint Server.

Allowed Values:

Read only.

However, if you click the process template name,
the Web Part displays a list of the following actions
that can be performed on the selected process
template:

• Initiate New Process - Initiates a new process.

If you have a process template associated to
more than one SharePoint library, or if you have
more than one content type associated with the
SharePoint library, you can choose the correct
option for each library or content type from the
action menu.

• View Process Model - Displays the process
model of the selected process template on a
Process Viewer page.

Applications Definition:

Displays the application name associated with the
process template.

Allowed Values:

Read only.

Description Definition:

Displays the optional free text description about
the process template deployed on the AgilePoint
Server.

Allowed Values:

Read only.
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Configuration Options - Process Model List Web Part
Sets up the SharePoint Process Model List Web Part.

Navigation

1. In SharePoint, navigate to the Process Model List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Field Definitions

Field Name Definition

Type of List Definition:

Determines the process templates to be retrieved.

Allowed Values:
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Field Name Definition

• ProcessTemplates - Retrieves all process
templates, or a list of process templates
specified in the Templates field.

• ProcessTemplatesByRole - Retrieves process
templates that apply to the SharePoint user's
AgilePoint role.

Default Value:

ProcessTemplates

Templates Definition:

Specifies process templates the Web Part uses to
filter process instances.

Allowed Values:

One or more process template names.

You can enter multiple process template names,
separated by semicolons (;).

Default Value:

None

Items Per Page Definition:

Specifies the number of items to display on one
page in the Web Part.

Allowed Values:

An integer.

Default Value:

10

Template Column Display Name Definition:

Sets the name of the column that displays the
process template names.

Allowed Values:

The process template column's name you want.

Default Value:

None

Adding the Process Model List Web Part to SharePoint
To add the AgilePoint Process Model List Web Part to SharePoint, do the following.
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Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the site page where you want to add the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Click Add a Web Part.

2. In the Categories pane, click AgilePoint.

3. In the Web Parts pane, click AgilePoint Process Model List.

4. Click Add.

Removing an AgilePoint Web Part from SharePoint
To remove an AgilePoint Web Part from SharePoint, do the following.

Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the site page where you want to remove the AgilePoint Web Part.

2. Click Site Actions > Edit Page.

Instructions

1. Move the pointer over the Web Part you want to remove from the site page, and then click the Web Part
arrow to display the list. The Arrow button appears only when you move the pointer over the Web Part
window.

2. In the list, click Delete.

Using the Process Model List Web Part
By clicking on a process template name, the Web Part will show dynamically the actions that can be performed
on the selected process template. If you have a process template bound to more than one SharePoint Library,
or if you have more than one content type associated with the SharePoint Library, you can choose the correct
option for each library or content type from the action menu.
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ListForm Web Part
The AgilePoint ListForm Web Part allows you to use a SharePoint List as the form UI for manual tasks. This
feature provides an easy way of building forms with different views based on a SharePoint List. A simple
configuration window allows you to determine how fields on the form are displayed to the end-user (e.g. Editable,
Locked, or Hidden). This drastically simplifies the effort and time required to build UI forms and therefore,
building processes has become even easier for business users.

The only requirement to use AgilePoint ListForm is that the Web Part is deployed and activated on the
SharePoint site where AgilePoint ListForm will be used.

On SharePoint, the ListForm Web Part operates in the background, managing the display settings (show/hide,
enable/disable) for ListForms that are defined in an AgilePoint process. The ListForm Web Part is not visible to
the end user.

For more information, see ListForm in the Documentation Library.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Process Launcher
A SharePoint Library, List, or Content Type can be associated to an AgilePoint Process Model using the
standard SharePoint approach. The AgilePoint Process Launcher allows you to easily workflow-enable regular
SharePoint Libraries, Lists, and Content Types. It allows you to specify which process template will be invoked
when a process is initiated within a specific SharePoint Form Library, List, or Content Type.

The following procedure explains how to workflow-enable a Form Library in SharePoint. Note that the procedure
is similar for Document Libraries and Content Types. For Content Types, access the content type you want (Site
Settings > Site Content Type Gallery), and modify the workflow settings as you would for a Form Library or
List.

To workflow-enable a SharePoint Form Library, do the following.

Prerequisites

• To perform this action, a SharePoint user must have Contribute privileges on both the library and the
AgilePoint Configuration List. (The user can also complete the procedure by logging on using the
SPImpersonater account.)

Navigation

Note:  The navigation for this task varies, depending upon your SharePoint version and the SharePoint
settings in your local environment. For more information, see the documentation for SharePoint

1. Within the SharePoint Form Library, click Settings > Form Library Settings.

2. Click Workflow settings.

Instructions

1. In the SharePoint workflow settings, select AgilePoint Process Launcher, and check the Start this
workflow when a new item is created check box.

2. Select a process from the AgilePoint Process Model list and select the desired version from the Select
Process Model Version list box.

3. After selecting the version of the AgilePoint Process Model, it will show the Process Model image. Click on
Submit to complete the SharePoint entity, AgilePoint process association.

4. Upload a new document to the library. If you have checked the check box Start this workflow when a
new item is created in Step 3, it will trigger the associated AgilePoint process when an item is created or
uploaded to the library. Refresh the page and you will see the In Progress link below the process name
column.

5. If Start this workflow when a new item is created was not checked at the time of creating the workflow
association, you can start the workflow manually. Click on the drop down button next to the list item.

6. Click Workflows.

7. Click the AgilePoint Process that you want to trigger for this item.

Note:  There may be multiple workflows associated to the library.

8. When clicking on the In Progress link of the item, it will show the AgilePoint workflow status page.
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9. The assigned user can take an action by clicking on the task name in the AgilePoint Task List.

10. Once the process completes, it shows as Completed status.
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Process Viewer
The Process Viewer is a web page that displays the current status of a process instance using a visual display.
The following functionality is available in the Process Viewer:

• The ability to complete a task.

• A green border identifies an active task, a red border identifies an overdue task. 

• The View Yammer Conversation option provides the ability to open a Yammer conversation, if one is
available.
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Manual Task Sample Pages
Several Web pages are provided that implement generic user interfaces for several typical Manual activities.
These Web pages correspond to the special Manual AgileShapes built-in to AgilePoint Envision in the Microsoft
SPS stencil (e.g. Approve, Complete, Publish, and Submit). These pages are selected using the Work To
Perform property for a Manual activity.

For more information, see AgileWork - Common Setup in the Documentation Library.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Customizing and Extending Web Parts
This section describes options for modifying AgilePoint Web Parts. These features mainly use standard
SharePoint functionality that is also supported by the AgilePoint Web Parts.

Basic Web Part Modifications
You can use common SharePoint functionality to modify AgilePoint Web Parts.

Modifying Web Part Display Properties
1. On the Web Part, click the drop-down arrow and select Modify My (Shared) Web Part. The page displays in

edit mode.

2. Modify the Web Part as desired and click Apply.

Personalizing Web Parts
Personalization is a standard SharePoint functionality which permits each user of a site to personalize
the pages and the elements in them that he/she has access to. These Web Parts are designed to permit
personalization. This permits a user to configure the Web Parts including Filters, Sort By and Group By settings
and these settings will persist for the user. To personalize an element, it first needs to have the corresponding
AllowPersonalization property for that element set to true (If not present, you need to add it). For example the
Welcome page (Default.aspx) of a top level site in a Publishing site collection has this property set to false for
all Web Part Zones, meaning that, in order to enable Personalization, it is first necessary to set it to true using
SharePoint Designer.

Once this is done, it is possible to personalize a page similar to any SharePoint page. See the SharePoint
documentation from Microsoft for detailed instructions.

Setting Up Web Part Connections
The Web Parts can be connected with other Web Parts using standard SharePoint connections. In addition, the
Process Template Web Part can act as a provider for the Process Instance Web Part.

You can also use the Standard SharePoint Filter Web Parts. For example, you can use the Text Filter Web Part
to filter the Task List Web Part by Task Name. For details, see the SharePoint documentation from Microsoft.

To set up the Web Part connections, do the following.

Prerequisites

• These instructions assume you are using SharePoint 2010 in a standard configuration. The exact procedure
depend upon the version of SharePoint you are using and the settings in your local environment.

Navigation

1. In SharePoint, navigate to the AgilePoint Web Part you want. For example, Site Actions > Edit Page.
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Instructions

1. On the Web Part window, click the Arrow button, and then click Connections > [Type of connection you
want] > [Web Part to be connected to the current one].

The following type of Web Part connections are supported to connect the current Web Part to another Web
Part:

Type of Web Part Connection Definition

Send Row of Data To Passes the selected row of data from the current
Web Part to the other Web Part.

Get Parameters From Fetches the selected data from the other Web Part
to the current Web Part.

Get Filter Values From Fetches the selected filter values from the other
Web Part to the current Web Part.

2. On the Choose Connection window, under the Choose Connection tab, select the connection type, and
then click Configure:

Field Name Definition

Connection Type Definition:

Determines the type of connection you want. You
can fetch values for a column that you want to
filter or data you want to use.

Allowed Values:

• Get Filter Values From

• Get Parameters From

Default Value:

Get Filter Values From

3. On the Choose Connection window, under the Configure Connection tab, complete the fields, and then
click Finish:

Field Name Definition

Provider Field Name Definition:

Determines the column name of the other Web
Part to fetch the data.

Allowed Values:

The name of your column.

Default Value:
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Field Name Definition

Assigned To - The value depends on the other
Web Part column names.

Consumer Field Name Definition:

Determines the column name of the current Web
Part you want to display the data retried from the
another Web Part.

Allowed Values:

The name of your column.

Default Value:

None

Customizing a Process Name
To customize a process name for InfoPath processes, do the following.

Instructions

1. Modify the code in the script.js file to customize the process name for InfoPath Client processes.

a. Open the file [AgilePoint Envision installation folder]\InfoPath\script.js.

b. Replace the code dav.FileName = fileName; code with the following code:

// Submit new form using InfoPath WebDAV Adapter
function CreateInfoPathFormByWebDAV(webdavAdapterName, fileName)
{
 var obj = new ActiveXObject("AgilePointInfoPath.Integration");
 var saveLocation = obj.GetDefaultSaveLocation();
 
 var dav = XDocument.DataAdapters(webdavAdapterName);
 dav.FolderURL = saveLocation;
 
 if (dav.FileName.toLowerCase() == "form.xml")
 {
    dav.FileName = fileName;
 }
 dav.Submit();

 XDocument.UI.Alert( "InfoPath form has been submitted successfully.\n
\nDocument Name :  " + fileName);
}

2. In the InfoPath form, modify the data connection for Submit:

a. In InfoPath, open an InfoPath form you want.

b. Open Data Connection Wizard. You can access the Data Connection Wizard via: File > Info > Submit
Options > SharePoint Library > Manage.

c. On the Data Connection Wizard, click Modify.

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
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d. In the Form Name field, click the Function button, and then insert a formula in the following format:

<Formula name>("_!_",<Field name 1,"-",<Field name 2,"_!_,now())

In this format, anything between the combination of the Underscore Exclamation Underscore delimiters
(_!_) becomes the process name in the Web Parts. The now() function is concatenated outside the
delimiters to ensure that the file names are unique.

Example:

<concat>("_!_",<EmpName,"-",<EmpDeptt>,"_!_,now())

In this example, EmpName-EmpDeptt becomes the process name in the Web Parts. The current date is
added to the process name to ensure that the file name is unique.

Custom Data Sources for Web Parts 
AgilePoint SharePoint Integration supports displaying data from a custom data source on the Task List or
Process Instance List SharePoint Web Parts.

Out of the box, AgilePoint provides custom data source configurations for SharePoint lists and custom attributes
available on AgilePoint Server. However, you can also custom code your own custom data source configuration
using the integration tools AgilePoint provides.

Deploying a Custom Data Source
To publish a custom data source for use with AgilePoint, do the following.

Note:  You do not need to complete this step if you are using a SharePoint list or custom attribute
available on AgilePoint Server as your custom data source.

Instructions

1. Create an assembly with a class that implements the IWebPartDataSource interface. This class should
contain your custom logic to get data from external Data Source. The assembly should be strongly named.

The following specifications describe the interface:

• Pi ids parameter - Contains all process instance IDs the Web Part will render. This is useful if you want
to filter your queries to external data source based on process instance ID. In fact, AgilePoint strongly
recommends you use this parameter to optimize the performance, based on this diagram:
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• Fields parameter: - An array of NameValues. Contains the fields that are configured for rendering on
Web Part results. The name property of NameValue is the internal name of the field, and the value is the
display name of the field.

• Filters parameter - An array of NameValues. Contains the filters for the data source. The Name property
of NameValue is the internal name of the field, and the value is the value of the filter.

• ConfigData parameter - Is an array of NameValues. It contains configuration data for the data source.

• Return type - You must return a DataTable with your custom data. This DataTable should contain a
column named ProcessInstanceID. This column is essential to merge with the main data source.

• GetRequiredParameters method - This method enables you to specify what parameters are needed
to configure the data source. On configuration-time, those parameters will be rendered on Data Source
Parameters configuration grid.

2. Deploy the assembly to the GAC.

Setting Up a Custom Data Source
You can use custom data sources in the SharePoint Task List and  Process Instance List Web Parts. To
configure the custom data sources in one of these Web Parts, do the following.

Navigation

1. On your SharePoint site, navigate to the AgilePoint Configuration list. For example, View All Site Content >
AgilePoint Configuration.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint

2. On the AgilePoint Configuration list, click New > AgilePoint Config Setting Item.
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Instructions

1. On the AgilePoint Configuration: New Item page, Modify the values in the following fields as required:

Field Name Definition

Application Enter CustomDataSources.

AP Setting Key The exact name of the custom data source. For the
data sources provided by AgilePoint, the names
must be precisely as follows:

• SharePoint List - SharePoint List DataSource

• Custom Attribute - Custom Attr

AP Setting Value The assembly information for your custom
data source. The following are examples of the
information required for the data sources provided
by AgilePoint:

• SharePoint List -
AgilePoint.SharePoint.CustomDataSources.SharePointListDataSource,
AgilePoint.SharePoint.CustomDataSources,
Version=1.0.0.0, Culture=neutral,
PublicKeyToken=b7c6f89c2c983acd

• Custom Attribute -
AgilePoint.SharePoint.CustomDataSources.CustomAttributesDataSource,
AgilePoint.SharePoint.CustomDataSources,
Version=1.0.0.0, Culture=neutral,
PublicKeyToken=b7c6f89c2c983acd

Description An optional free text description of the data source.

Encrypted Leave unselected.

2. Click OK.

Custom Data Sources Configuration Window
Sets up custom data sources for a Web Part. Custom data sources enable you to populate columns in the Web
Part from a data source of your choice, such as a SharePoint list or a database.
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Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Field Definitions

Field Name Definition

Available Data Sources Definition:

Displays the data sources that have been set up in
the AgilePoint Configuration List, and are available
for the Web Part.

Allowed Values:

A list of preconfigured data sources.
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Field Name Definition

Configured Data Sources Definition:

Specifies the data sources that are active for the
selected column.

Allowed Values:

A list of preconfigured data sources.

Default Value:

None

Add Function:

Moves the selected data source item from the
Available Data Sources box to the Configured Data
Sources box.

For more information, see Adding a Custom Data
Source in the Documentation Library

Remove Function:

Moves the selected data source item from the
Configured Data Sources box to the Available Data
Sources box.

For more information, see Removing a Custom
Data Source in the Documentation Library

Internal field name Definition:

Specifies the internal name for the SharePoint
custom column. The internal name acts as an
identifier for the data you want to display from the
data source. The column's internal name is not
visible to the SharePoint users.

Allowed Values:

An internal SharePoint custom column name.

Default Value:

Type Internal field name - Indicates that you have to
type the internal SharePoint column name. In itself,
this is not a valid value.

Display field name Definition:

Specifies the SharePoint custom column's name
you want to appear in the SharePoint list.

Allowed Values:

A SharePoint custom column name.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Field Name Definition

Default Value:

Type Display field name - Indicates that you have to
type the SharePoint custom column name you want
to display in the SharePoint list. In itself, this is not a
valid value.

Field Type Definition:

Specifies the data type for the custom data column.

The values in this field determine how the data is
displayed in the Web Part.

Allowed Values:

• DateTime - Sorted according to DateTime
format.

• Date - Sorted according to DateTime format.

• Integer - Sorted numerically.

• Decimal - Sorted numerically.

• Currency - Sorted numerically.

• String - Sorted alphabetically. Only String fields
can be rendered as a link.

Render as Link Definition:

Determines whether the custom column is displayed
as a hyperlink in the SharePoint list.

Allowed Values:

• Deselected - The custom column is not
displayed as a hyperlink in the SharePoint list.

• Selected - The custom column is displayed as
a hyperlink in the SharePoint list.

You must specify the URL for the link.

Note:  For column data to render as a link
the data type must be String or blank. If
Render as Link is selected and any other
data type is selected, the Render as Link
option is ignored.

Default Value:

Deselected

Url Definition:

Allows you to enter a URL for the link if the custom
column's value is to be rendered as a link.
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Field Name Definition

Allowed Values:

A valid URL.

This URL can include one ore more custom
attributes.

Default Value:

http://mysite?EmpID={0}

This value indicates you must specify the URL in
the given format. In itself, this is not a valid value.

Example:

• http://${SharePointListUrl}/

• http://${MySharePointServer}:${MyPort}/
${MySharePointList}

Update Function:

Allows you to save the modifications or values
entered, as appropriate:

• Data Source Columns - Allows you to save the
custom column values entered.

When you click the Update button, the Add
Item, Edit, and Delete buttons are available to
add a new custom column, modify or delete the
values entered.

• Data Source Parameters - Allows you to
save the URL entered for the SharePoint list.
You can update the URL value only for the
SharePoint list data sources.

The options in the Data Source Parameters
section are visible only when a SharePoint list
data source is selected in the Configured Data
Sources list.

Add Item Function:

Allows you to add a custom column.

For more information, see Adding a Custom Column
to a SharePoint Web Part in the Documentation
Library

Edit Function:

Allows you to modify or enter the values as
appropriate:

• Data Source Columns - Allows you to modify a
custom column values for the SharePoint Web
Part.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Field Name Definition

For more information, see Editing a Custom
Column in a SharePoint Web Part in the
Documentation Library

• Data Source Parameters - Displays a Value
box to provide the URL for the SharePoint
list. You can set the URL value only for the
SharePoint list data sources.

The options in the Data Source Parameters
section are visible only when a SharePoint list
data source is selected in the Configured Data
Sources list.

When you click the Edit button, the Update and
Cancel buttons are available to save or cancel the
modifications.

Delete Function:

Allows you to delete the SharePoint custom column.

Value Definition:

Specifies the URL of the SharePoint list you want to
use as your custom data source.

Allowed Values:

A valid SharePoint list URL.

The options in the Data Source Parameters section
are visible only when a SharePoint list data source
is selected in the Configured Data Sources list.

Default Value:

None

Adding a Custom Data Source
To add a custom data source to the Web Part, do the following.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

http://documentation.agilepoint.com/SupportPortal/Docs/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html
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Instructions

1. On the Custom Data Sources Configuration Window window, select the item you want in the Available
Sources list, and click Add.

Removing a Custom Data Source
To remove a custom data source from a SharePoint Web Part, do the following.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Instructions

1. On the Custom Data Sources Configuration Window window in the Configured Data Sources list, select the
item you want.

2. Click Remove.

Adding a Custom Column to a SharePoint Web Part
To add a custom column to a SharePoint Web Part, do the following.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Instructions

1. On the Custom Data Sources Configuration Window window in the Configured Data Sources list, select the
item you want.

2.

Click the Add button ( ).

3. Modify the values in the following fields as required:
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Field Name Definition

Internal field name An identifier for the data you want to display from
the data source. SharePoint users do not see this
text.

Display field name The column name you want to appear in the
SharePoint list.

Render as Link? When selected, specifies that the column appears in
the SharePoint list as a hyperlink.

For column data to render as a link the data type
must be String or blank. If Render as Link is
selected and any other data type is selected, the
Render as Link option is ignored.

Url If a column value is rendered as a link, specifies the
URL for the link.

4.

Click the Update button ( ).

Limiting Rows with Custom Data Columns
If you use custom columns from custom data sources for the Task List and Process Instance List Web Parts,
AgilePoint recommends limiting the number of rows that display in the Web Parts.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

Instructions

1. In the Web Part properties, change the value of the following property to 50 or lower.

Field Name Definition

Max. Tasks to Retrieve This property limits the number of tasks to retrieve.
Limiting the number of tasks to retrieve can help
improve performance.

If you are using columns that retrieve data from
Custom Data Sources, AgilePoint recommends
limiting this number to 50 or lower.
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Editing a Custom Column in a SharePoint Web Part
To edit a custom column in a SahrePoint Web Part, do the following.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Instructions

1. On the Custom Data Sources Configuration Window window, under Data Source Columns, click the Edit

button ( ) for the item you want.

2. Modify the values in the following fields as required:

Field Name Definition

Internal field name An identifier for the data you want to display from
the data source. SharePoint users do not see this
text.

Display field name The column name you want to appear in the
SharePoint list.

Render as Link? When selected, specifies that the column appears in
the SharePoint list as a hyperlink.

For column data to render as a link the data type
must be String or blank. If Render as Link is
selected and any other data type is selected, the
Render as Link option is ignored.

Url If a column value is rendered as a link, specifies the
URL for the link.

3.

Click the Update button ( ).

Removing a Custom Column from a SharePoint Web Part
To remove a custom column from a SharePoint Web Part, do the following.
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Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Instructions

1.

On the Custom Data Sources Configuration Window window, click the Delete button ( ) for the item you
want.

Modifying the URL for a SharePoint List Custom Data Source
If you are using a SharePoint list as a custom data source, you must provide the URL for the list. To specify the
SharePoint list URL, do the following.

Navigation

1. In SharePoint, navigate to the Task List or Process Instance List Web Part.

2. On the Web Part window, click the Arrow button, and then click Edit Web Part. The Arrow button appears
only when you move the pointer over the Web Part window.

The navigation for this task varies, depending upon your SharePoint version and the SharePoint settings in
your local environment. For more information, see the documentation for SharePoint.

3. In the Web Part properties, click Data Sources.

Instructions

1. On the Custom Data Sources Configuration Window window, under Data Source Parameters, click the Edit

button ( ) for the List Url item.

2. Modify the values in the following fields as required:

Field Name Definition

Value Specifies the URL of the SharePoint list that you
want to use as your custom data source.

3.

Click the Update button ( ).
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Extending AgilePoint Web Parts
You can extend the AgilePoint Task List Web Part and AgilePoint Process Instance List Web Part to include
custom actions. This is supported at the item level, as well as at the global level.

Custom Actions
This section provides instructions for adding Custom Actions in the AgilePoint Task List and AgilePoint Process
Instance List Web Parts. This is supported at the item level as well as at the global level. Many times there is a
requirement where apart from the built in task actions you need additional actions depending on some situation,
in that case, Custom Actions can be added. These Custom Actions can be easily added as a plug-in and when
configured, these custom actions will be available in the Web Parts along with other built in actions.

Custom Task Actions in the AgilePoint Task List Web Part
The following are the steps to design and configure Custom Actions:

1. Code the Custom Actions.

The user defined custom class needs to be derived from ICustomTaskListActions and needs to implement
the AddCustomActions method.

Sample:

public class CustomTaskListActions : ICustomTaskListActions
    {
    public StringBuilder AddCustomActions(StringBuilder sb, WFManualWorkItem wi,
 string currentUser)
    {
    string formRenderUrl = "FormRender.aspx";
    try
    {
    formRenderUrl =
 ConfigurationSettings.AppSettings["FormRenderURL"].ToString();
    }
    catch
    { }
    if (wi.UserID.ToLower() == currentUser && (wi.Status ==
 WFManualWorkItem.ASSIGNED || wi.Status == WFManualWorkItem.OVERDUE) && wi.Name
 == "FormRender")
    {
    sb.Append(AddMenuItem("Fill in", "window.open('" + formRenderUrl + "?WID=" +
 wi.WorkItemID + "')", "_layouts/images/edit.gif"));
    }
    
    return sb;
    }
    
    private string AddMenuItem(string text, string actionUrl, string imageUrl)
    {
    if (imageUrl == null || imageUrl == string.Empty)
    {
    imageUrl = "/_layouts/AP/Image/warn16.gif";
    }
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    string menuHtml = "<ie:menuitem id=\"" + Guid.NewGuid().ToString() + "\"
 type=\"option\" iconSrc=\"" + imageUrl + "\" onMenuClick=\"" + actionUrl + ";
\" text=\"" + text + "\" title=\"" + text + "\" menuGroupId=\"2147483647\"></
ie:menuitem>";
    return menuHtml;
    }
    }

The AddCustomActions method takes three input parameters:

• Stringbuilder

• WFManualWorkItem

• Currentuser

WFManualWorkItem is the WorkItem for which the task needs to perform the action.

2. The custom Assembly should have a strong name.

3. Drop the custom Assembly in the GAC as well as the bin directory of the SharePoint Web application.

Configuring the Custom Action within the Task List Web Part

There are two different ways for which you can bind your custom Assembly to the AgilePoint Task List:

• Registering the custom Assembly in the GAC:

Add a new setting in the appSettings node where the key is “CustomAgilePointTaskActions” and the value is
“Class name, Assembly name” Sample:

<add key="CustomAgilePointTaskActions"
 value="SPCustomAction.CustomTaskListActions,SPCustomAction" />

• Registering the custom Assembly in the AgilePoint Configuration List:

Add a new entry in the AgilePoint Configuration List with the name as CustomAgilePointTaskActions, where
the value is class name, assembly name

Once the custom Assembly is properly registered, it will be available in your task list as shown below:
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Global Actions in the AgilePoint Task List Web Part

Global Actions are similar to Custom Task Actions, except for the following differences:

1. Derive the Custom Global Actions class from ICustomTaskListGlobalActions, and the AddCustomActions
method accepts WFManualWorkItem[] instead of WFManualWorkItem.

2. During the configuration, you need to use the key “CustomAgilePointGlobalTaskActions” instead of
“CustomAgilePointTaskActions” in the web.config and AgilePoint Configuration List.

 Change Priority

This section provides information for a Global Action called Change Priority in the AgilePoint Task List Web Part.
It allows the user to adjust the priority setting of tasks in the AgilePoint Task List Web Part.

Download the attached project files.

Extract the files, and drop the dll in GAC and bin directory of the SharePoint Web application. Also copy the file
[SharePoint server extensions folder]\TEMPLATE\LAYOUTS\AP\ChangePriority.aspx.

Add an entry in the web.config or AgilePoint Configuration List as shown below: web.config:

<appSettings>
  <add key="CustomAgilePointGlobalTaskActions" 
      value="MyPrivate.CustomAction.GlobalCustomActionExtender,
      MyPrivate.CustomAction.ChangePriority" />
</appSettings>

-Or-

AgilePoint Configuration List:

• Application - CustomAgilePointGlobalTaskActions

• AP Setting Key - CustomAgilePointGlobalTaskActions

• AP Setting Value -
MyPrivate.CustomAction.GlobalCustomActionExtender,MyPrivate.CustomAction.ChangePriority

Downloads

ChangePriority.zip

Custom Actions in the AgilePoint Process Instance List Web Part
This section provides the steps to design and configure Custom Actions in the AgilePoint Process Instance List
Web Part:

1. Add a reference to Ascentn.SharePoint.Common.v2.dll.

2. Code the Custom Actions.

The user defined custom class needs to be derived from ICustomProcessInstanceAction and needs to
implement the AddCustomActions method.

Sample:

using Ascentn.SharePoint.Common;
public class CustomTaskListActions : ICustomProcessInstanceAction

{
  public StringBuilder AddCustomActions(StringBuilder sb, string piid, string
 currentUser)
    

http://documentation.agilepoint.com/SupportPortal/DOCS/ProductDocumentation/CurrentRelease/DocumentationLibrary/maps/index.html#kbDefaultInstallLocations.html
../../../downloads/ChangePriority.zip
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  {
    int count = 0;
    string formRenderUrl = "FormRender.aspx";
    formRenderUrl = formRenderUrl + "?PIID=" + piid;
    sb.Append(AddMenuItem(count.ToString(), "window.open('" + formRenderUrl +
 "')", 
        "_layouts/images/edit.gif"));
    return sb;
  }
    
  private string AddMenuItem(string text, string actionUrl, string imageUrl)
    
  {
    if (imageUrl == null || imageUrl == string.Empty)
        
    {
      imageUrl = "/_layouts/AP/Image/warn16.gif";
    }
    string menuHtml = "<ie:menuitem id=\"" + Guid.NewGuid().ToString() + "\" 
         type=\"option\" iconSrc=\"";
    menuHtml += imageUrl + "\" onMenuClick=\"" + actionUrl + ";\" text=\"" +
 text + 
           "\" title=\"";
    menuHtml += text + "\" menuGroupId=\"2147483647\"></ie:menuitem>";
    return menuHtml;
  }
}

3. Build and drop the assembly in the GAC and the bin directory of the SharePoint Web application.

4. Configure the Custom Action in the AgilePoint Process Instance List Web Part:

This can be done in two ways:

• Registering the custom assembly in the GAC. Add a new setting in the appSettings node with the key as
“CustomProcessInstanceAction” and the value as “Class name, Assembly name”.

For example:

<add key="CustomAgilePointTaskActions" 
  value="SPCustomAction.CustomTaskListActions,SPCustomAction" />

• Registering the Custom Assembly in the AgilePoint Configuration List.

Add a new item in the AgilePoint Configuration List where the Application name is
CustomProcessInstanceAction and the AP Setting Value is class name, assembly name

Custom Global Actions in the AgilePoint Process Instance List Web Part

Global Actions are similar to Custom Actions in the AgilePoint Process Instance List except for the following
differences:

1. You need to derive your custom Global Actions class from:

ICustomProcessInstanceGlobalAction, the AddCustomActions method accepts string[] PIIDs instead of
string PIID.

2. During configuration, you need to use the key “CustomProcessInstanceGlobalAction” instead of
“CustomProcessInstanceAction” in the web.config and the AgilePoint Configuration List.
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SPDoc Metadata Binding
In SPDoc based process templates, you can access the values of custom SharePoint Document Library's
metadata columns entered by the user when a document is uploaded. This data can then be used in your
process － for example, to determine the workflow in your process, or to display information in an email
notification.

To bind the SharePoint data with a SPDoc process, do the following.

Prerequisites

• A SharePoint column:

1. In SharePoint, navigate to the Document Library.

2. Under the Library tab, click Create Column, and then complete the fields to create a column, such as
column name and column data type. For example, a column named Department.

Navigation

1. In Envision, open a  Microsoft SPDoc process template.

2. Navigate to the Generic BPM stencil.

3. On the Generic BPM stencil, drag the Multiple Condition AgileShape, and drop it on the process template.

4. On the New Condition Activity Window - Multiple Condition AgileShape, click the Ellipses button.

Instructions

1. To bind the SharePoint data with the process, on the Select SharePoint Library Column Window, select the
Show All check box.

2. Select the column for data binding, and then click OK.

Now, when you upload a document in the document library, this field is displayed and you can enter a value in
the text field provided.

Then, a new process is initiated, and the process retrieves the value of the metadata from the SharePoint
column － Department in this example, and routes the process as designed based on the column's value
entered by the user － the department name in this example.
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Localization
If the AgilePoint database locale is different from the SharePoint machine locale, you must add a new string
value － APDBCulture － in the SharePoint machine registry.

To add a new string value in the SharePoint machine registry, do the following.

Navigation

1. Click Start > Run.

2. In the Open field, type regedit.

3. Click OK.

4. In the Registry Editor window, navigate to the registry for the SharePoint machine:
HKEY_LOCAL_MACHINE/SOFTWARE/Ascentn/SharePoint

Instructions

1. Under the HKEY_LOCAL_MACHINE/SOFTWARE/Ascentn/SharePoint node, add a new string value:
APDBCulture.

The value of the APDBCulture is the localization code for the locale used in the AgilePoint database. For
example, en-US, ar-SA.
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Performing Document Locking
In SharePoint, document locking can be performed through the CheckOut and CheckIn functionality. To perform
the document locking, do the following.

Prerequisites

• Create a custom AgilePart using the AgilePart project template in AgilePoint Developer.

• Register the custom AgilePart in Envision.

Navigation

1. In AgilePoint Envision, open a process template.

2. Navigate to the Generic BPM stencil.

3. On the Generic BPM stencil, drag the AgilePart AgileShape, and drop it on the process template.

4. On the Set Context Properties Window - AgilePart, select a custom AgilePart to associate with this instance
of the AgileShape.

5. To view the entire list of properties, in the Design Tasks pane, click Show Properties.

Instructions

1. Similar to the Rename AgilePart, implement a CheckIn/CheckOut AgilePart that handles the document
locking and releasing mechanism.

The following are some code snippets of using the SharePoint SDK to implement the CheckOut and CheckIn
operation:

public void CheckOut()
{
       SPWeb web = new SPSite("http://virtual:101/sites/s1/s1/a37").OpenWeb(); 
       SPFile file = web.GetFile("http://virtual:101/sites/s1/s1/a37/cdl1/
test.htm");
       file.CheckOut();
       Console.WriteLine("Checked Out");
}
public void CheckIn()
{
       SPWeb web = new SPSite("http://virtual:101/sites/s1/s1/a37").OpenWeb(); 
       SPFile file = web.GetFile("http://virtual:101/sites/s1/s1/a37/cdl1/
test.htm");
       file.CheckIn("This is the check in comment by console app.");
       Console.WriteLine("Checked In");
}
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Enable or Disable Debug Mode
AgilePoint SharePoint Integration supports an optional Debug mode. When enabled, this feature causes
additional information to be logged to the AgilePoint SharePoint Integration log files. This mode can cause a
large amount of data to be written to the logs, so it is not recommended to enable this all the time. However,
when troubleshooting possible problems, it is very useful to enable this feature because the additional
information in the logs makes analyzing the system's behavior much easier.

Navigation

1. Open the SharePoint Configuration Manager.

Instructions

1. To log additional information to the AgilePoint SharePoint Integration log files, enable the Debug logging
setting.
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Checking the AgilePoint SharePoint Integration
Log Files
AgilePoint SharePoint Integration creates and maintains log files to store certain informational, warning, and/or
error messages about the server and the workflow engine. These log files are created automatically.

Prerequisites

• To access the FTP location, the Impersonator user must have write permission on FTP server.

Navigation

1. In SharePoint, open the AgilePoint Configuration List .

Instructions

1. To access the logs, simply view the relevant files using a text editor.

The location of the log files comes from the AgilePoint Configuration List in SharePoint, for example C:
\NewSPLog. You can give the FTP location also, for example ftp://netsvr1/AgilePontSharePoint/Log).

Some of the log files are only created when additional Debug mode logging is enabled.

2. You can provide switches for logging. The following are the available switches:

• All 

• Info

• Debug

• Error

• None

You can give multiple switches separating by a comma (,). For example, Debug, error, Info.

ftp://netsvr1/AgilePontSharePoint/Log
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(v1 Only) SharePoint Configuration Manager
The SharePoint Configuration Manager utility allows you to configure the AgilePoint SharePoint configuration
settings.

Impersonation
The Impersonation tab allows you to enter the domain-qualified username and password of the AgilePoint user
account that SharePoint should use to interact with AgilePoint Server at run time.

Note:  This user should have access rights to both AgilePoint and SharePoint.

Note:  Be sure to click Apply to commit your changes.

System Setting
The Log group box on the System Setting tab allows you to turn on/off different types of logging.

Note:  Be sure to click Apply to commit your changes.

Once data is available, AgilePoint will create the necessary folders to store the data.  Error logging is fixed to
always log, and is the most important type of logging for troubleshooting and is generally what is requested by
Ascentn Support if issues surface. It is optional to turn on/off Information and Debug logging. The Information
log provides sequential session descriptions. The Debug log provides information about the flow and status of
activities. Be sure to purge these directories periodically to avoid using unnecessary disc space.

Below is an example of what the log files record.

Debug:
01/21/2008 11:10:20 <<< ConfigSetting deserializing successfully.(id=0).
01/21/2008 11:10:23 <<< ConfigSetting deserializing started....
01/21/2008 11:10:23 <<< Total 0 AgileLookProfiles, 0 are restored successfully.
Total 0 DocLibBindings, 0 are restored successfully.
Total 0 GenericListBinding, 0 are restored successfully.
Total 0 Sections, 0 are restored successfully.
01/21/2008 11:10:23 <<< ConfigSetting deserializing successfully.(id=0).
01/21/2008 11:10:26 <<< ConfigSetting deserializing started....

Informational:
07/25/2007 18:14:57 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version = Ascentn.SharePoint.Common, Version=4.0.0.1,
 Culture=neutral, PublicKeyToken=2f06ef94bac0a40f)
07/25/2007 18:14:57 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version = Ascentn.SharePoint.Common, Version=4.0.0.1,
 Culture=neutral, PublicKeyToken=2f06ef94bac0a40f)
07/25/2007 18:14:57 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version = Ascentn.SharePoint.Common, Version=4.0.0.1,
 Culture=neutral, PublicKeyToken=2f06ef94bac0a40f)
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07/25/2007 18:34:56 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version = Ascentn.SharePoint.Common, Version=4.0.0.1,
 Culture=neutral, PublicKeyToken=2f06ef94bac0a40f)
07/25/2007 18:34:56 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version = Ascentn.SharePoint.Common, Version=4.0.0.1,
 Culture=neutral, PublicKeyToken=2f06ef94bac0a40f)
07/25/2007 18:34:56 <<< Ascentn.SharePoint.Common has been initialized
 successfully. (Assembly version =
Error:
01/21/2008 10:57:09 <<< FillCache()
      Exception (Type=ThreadAbortException)
      Error = Thread was being aborted.
      CallStack =    at System.Array.Copy(Array sourceArray, Int32 sourceIndex,
 Array destinationArray, Int32 destinationIndex, Int32 length, Boolean reliable)
   at System.Array.CopyTo(Array array, Int32 index)
   at System.Collections.ArrayList.InsertRange(Int32 index, ICollection c)
   at System.Collections.ArrayList.AddRange(ICollection c)
   at System.DirectoryServices.PropertyValueCollection.PopulateList()
   at System.DirectoryServices.PropertyValueCollection..ctor(DirectoryEntry entry,
 String propertyName)
   at System.DirectoryServices.PropertyCollection.get_Item(String propertyName)
   at Microsoft.SharePoint.Administration.SPIisWebSite.get_ServerComment()
   at
 Microsoft.SharePoint.Administration.SPVirtualServer.InitializeIisComponents(SPIisWebSite
 iisInstance)
   at Microsoft.SharePoint.Administration.SPVirtualServer..ctor(SPIisWebSite
 iisInstance)
   at Microsoft.SharePoint.Administration.SPVirtualServerCollection.Undirty()
   at Microsoft.SharePoint.Administration.SPVirtualServerCollection..ctor()
   at Microsoft.SharePoint.Administration.SPGlobalAdmin.get_VirtualServers()
   at Ascentn.SharePoint.Common.SPSVirtualServerCache.FindSPVirtualServerByID(Guid
 virtualServerId)
   at l..ctor(DboSPSVirtualServer A_0)
   at Ascentn.SharePoint.Common.SPSVirtualServerCache.a()

The "Default Event Handler" group box on the System Setting tab displays the class that is invoked for the
SharePoint Event Handling. This information is exposed to provide the option to implement customized event
handling.

Database
This window allows you to select the AgilePoint SharePoint Integration database and specify the authentication
information.

Note:  Be sure to click Apply to commit your changes.

SharePoint Web Applications
This window allows you to select from a list of SharePoint Web Applications and enable/disable each of the
SharePoint Web Applications as desired. Detailed information about each SharePoint Web Application is
displayed when the SharePoint Web Application is highlighted in the list.

This window also allows you to view and edit the SharePoint Configuration Settings XML. To view/edit the
SharePoint Configuration Settings XML, click the Edit button. This window provides the functionality to export
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the SharePoint Configuration Settings XML to the XML editor of your choice by clicking the Export button. When
done editing the XML, click the Import button and import the changes.

Clicking the Show all Virtual Servers button allows you to view a list of all Virtual Servers on the physical
machine.
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(v1 Only) Creating a workflow-enabled
SharePoint Site
With the AgilePoint SharePoint Integration, you can deploy your process templates to AgilePoint Server and then
create your own sites and libraries to associate with these process templates. After you install the AgilePoint
SharePoint Integration, your SharePoint has the features needed to create AgilePoint enhanced sites and
libraries.
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